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PURPOSE OF THIS GUIDANCE DOCUMENT

Notice

This document is for information purposes only and does not constitute a decision or finding by the
Registrar of Lobbyists for British Columbia or their delegates. This guidance does not affect the powers,
duties or functions of the Registrar of Lobbyists, or their delegates, regarding any investigation or other

matter under the Lobbyists Transparency Act, respecting which the Registrar and their delegates will

keep an open mind. Responsibility for compliance with the Lobbyists Transparency Act remains with
each lobbyist.

The Lobbyists Transparency Act (“LTA”) came into effect on May 4, 2020. The legislation and the
Lobbyists Transparency Regulation set out requirements for registration of individuals and
organizations engaged in lobbying activities.

This Quick Guide summarizes the steps for organizations to create and update Registration
Returns. The full-length User Guide: Consultant Lobbyist Registration Returns is more detailed
and contains many more screenshots.

For information about Monthly Returns (Lobbying Activity Reports and updates to Registration
Returns), see User Guide — Monthly Returns and Lobbying Activity Reports.

Sign in to the Lobbyists Registry to create and submit Registration Returns and Lobbying Activity
Reports. You must also keep the information in your Registration Returns up to date.

The GETTING STARTED - REFERENCE GUIDE is a brief overview of the provisions of the current
legislation and regulation governing lobbying in BC, together with an explanation of the most
commonly-used features of the Lobbyists Registry. It is designed to answer common questions.

Links to the complete text of the LTA and the Regulation are available by clicking “Help” on the
top toolbar of each page of the Lobbyists Registry and selecting “Legislation”.

The ‘Help’ tab also has links to guidance documents, FAQs, other user guides under ‘Using the
Registry’, and contact information for our office.

Registration Returns, Monthly Returns, and Lobbying Activity Reports
The Designated Filer is the most senior paid officer of an organization that is lobbying. They are
responsible for creating a Registration Return for the organization and keeping it up to date as

long as the organization is carrying on lobbying activities in BC.

Registration Returns contain information about the organization and the in-house lobbyists,
together with high-level details of lobbying activities carried out by the in-house lobbyists.



https://www.lobbyistsregistrar.bc.ca/handlers/DocumentHandler.ashx?DocumentID=378
https://www.lobbyistsregistrar.bc.ca/handlers/DocumentHandler.ashx?DocumentID=379
https://www.lobbyistsregistrar.bc.ca/app/secure/orl/lrs/do/guest
https://www.lobbyistsregistrar.bc.ca/handlers/DocumentHandler.ashx?DocumentID=417
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Monthly Returns: an organization is required to file Lobbying Activity Reports and updates to
the Registration Return by the 15th of each month, IF there was lobbying activity to report, or
a change to the information in the Registration Return, in the preceding month.

Lobbying Activity Reports: must be filed if an in-house lobbyist for the organization lobbied one

or more senior public office holders in the preceding month. Create a Lobbying Activity Report
for each lobbying activity directed at a senior public office holder on behalf of the organization.

See user guide: Monthly Returns and Lobbying Activity Reports

For more information, see the following sections of the Frequently Asked Questions:
. Public office holders, senior public office holders, former public office holders
J Registration Returns; Monthly Returns; Lobbying Activity Reports

YOUR ACCOUNT IN THE LOBBYISTS REGISTRY

One account

There are two types of accounts: Designated Filer and Representative. In-house lobbyists do
not have their own accounts.

The most senior paid officer of your organization is the Designated Filer.

The Designated Filer may authorize a Representative to prepare and update Registration
Returns and Lobbying Activity Reports on their behalf. For more information on creating and
authorizing a Representative account, See User Guide - Account Management pages 20 — 30
and Quick Reference Guide for Representatives.

If the senior officer of your organization has changed, the Registration Returns and Lobbying
Activity Reports must be transferred and attached to the account of the new Designated Filer.
See Change Senior Officer/Designated Filer section below.

An individual will only ever have one account in the Lobbyists Registry. (Registry staff may
revise the type of account you have if necessary to allow you to carry out more than one role.)

If you had an account in the previous Lobbyists Registry, DO NOT CREATE A NEW ACCOUNT.
See Activating an Account from the Previous Lobbyists Registry below.

If you have an account in the current Lobbyists Registry but are unable to sign in to your
account, DO NOT CREATE A NEW ACCOUNT. The new account will be deleted and you’ll need


https://www.lobbyistsregistrar.bc.ca/handlers/DocumentHandler.ashx?DocumentID=379
https://www.lobbyistsregistrar.bc.ca/lobbyists-transparency-act/lta-frequently-asked-questions/
https://www.lobbyistsregistrar.bc.ca/handlers/DocumentHandler.ashx?DocumentID=376
https://www.lobbyistsregistrar.bc.ca/handlers/DocumentHandler.ashx?DocumentID=383
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to continue with your previous account. See Forgotten Password or Username for steps to get
access to your account.

Create a new Designated Filer account

1. Go to the Lobbyists Registry sign-in page:
https://www.lobbvistsregistrar.bc.ca/app/secure/orl/Irs/do/Ign

2. Create a new account by clicking on “Create an Account”.

O-R-L- BRITISH COLUMBIA www lobbyistsregistrar.bc.ca 4

Registry Search Tools v Reporting Tools v Lobbying Stafistics v XL Signin

Registry Dashboard

= Lobbyists Registry Sign In

Look under the Help menu item at the top of each page for links to Guidance Documents, FAQs, Using the Registry & User Guides, and the Lobbyists
Transparency Act and Regulation.

© Two New Features in the Lobbying Activity Report:
1. Adding MLAs: provides the ability to add one or more MLAs, including an option to add all MLAs
2. Coalition activity Checkbox: provides the ability lo declare a coalition activity

Sign In Register
&  Usemname Please read carefully before proceeding
+ Consultant Lobbyist: If you receive p it to lobby or arrange meetings on
behalf of a client, you must create your own account to register lobbying
activities with the Lobbyists Registry.

# | Password
= Organizations: @ If your functions as an employee, officer or director of an
Sign In organization include lobbying of BC public office holders, and you receive
on remuneration of any kind, your organization must create an account to register
lobbying activities within the Lobbyists Registry. For organizations, the most

senior paid officer is required to create an account as the designated filer.

/. Note: If you had a registration in the BC Lobbyists Registry between 2010
and May 4, 2020 you can activate your account here.

T z=m

3. Confirm you do not have an existing account in the Lobbyists Registry by ticking the check
box. Then click “Continue”.

4. Create a Designated Filer account by clicking on “Select” in the second box, which says,
“You are the most senior paid officer for an organization that has employees, officers or
directors who lobby.”


https://www.lobbyistsregistrar.bc.ca/app/secure/orl/lrs/do/lgn
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Designated Filer/Organization information

Designated
Filer/Most Senior
Paid Officer
Declaration

Read the statements, tick each box, click “Continue”.

Designated Filer
Information

Enter your First name, Last name, and Position title.
Enter the exact legal name of the organization.

Enter the organization’s mailing address and business telephone
number.

Email Addresses for
Designated Filer &
others

Enter the Designated Filer’s direct business email address. Enter it a
second time to confirm that it is correct.

Select “Yes” if you would like additional recipients to receive email
notifications from the Registry, and enter the additional email
addresses. We recommend you enter at least one
additional/alternative email address.

Username/password

Username and
Password

Enter a Username and Password for your Designated Filer account.

Usernames and passwords are case sensitive and must be at least 6
characters long.

Activate your Designated Filer Account

Activate your new
Designated Filer
Account

You must activate your account before you can submit Registration
Returns and Lobbying Activity Reports.

You will be sent an activation email. Click the link in the email to
activate your account. If you do not receive an activation email
within an hour, contact the Registry at info@bcorl.ca

Once your account is activated, you can sign in to the Lobbyists
Registry and create a Registration Return.



mailto:info@bcorl.ca
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Activate an account from the previous Lobbyists Registry

If you had registrations in the previous BC Lobbyists Registry (between 2010 and May 4, 2020),
your account and registrations were migrated into the new Lobbyists Registry. You must
activate your account and update the most recent registration for your organization if/when
you need to report lobbying activities.

To activate your account from the previous Lobbyists Registry and access your registration, you
will need two pieces of information:

The exact spelling of your name (first and last only), as entered in your most recent
registration.

The email address you entered in your most recent registration. NOTE: if that email
address is no longer valid, contact our office first. Ask us to enter your current email
address. Otherwise, you will not receive the emails & links you require to proceed.

If you have difficulty getting access to an existing account, contact Registry staff at

info@bcorl.ca.

1. Go to the Lobbyists Registry sign-in page:
https://www.lobbvistsregistrar.bc.ca/app/secure/orl/Irs/do/Ign

2. Click the link “activate your account here”.

= Lobbyists Registry Sign In

Look under the Help menu item at the top of each page for links to Guidance Documents, FAQs, Using the Registry & User Guides, and the Lobbyists
Transparency Act and Regulation

© Two New Features in the Lobbying Activity Report:

1. Adding MLAs: provides the ability to add one or more MLAs, including an option to add all MLAs
2. Coalition activity Checkbox: provides the ability to declare a coalition activity

Sign In Register

r Iy
& Usemame Please read carefully before proceeding
« Consultant Lobbyist: if you receive payment to lobby or arrange meetings on
" behalf of a client, you must create your own account to register lobbying
» Password
activities with the Lobbyists Registry.

Have you forgotten your password?

* Organizations: @ If your functions as an employee, officer or director of an

i organization include iobbying of BC public office holders, and you receive
remuneration of any kind, your organizajjon must create an account to register
lobbying activities within the Lobbyists FEegistry. For organizations, the most
senior paid officer is required to creg#e an account as the designated filer

/i Note: If you had a registrglion o pumus egistry between 2010
and May 4, 2020 you gan activate your account here
Create an Account



mailto:info@bcorl.ca
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3. Re-activation Process

Enter Name Enter your First name and Last name exactly as they were entered in
the previous BC Lobbyists Registry in your most recent registration
prior to May 4, 2020. Then click “Continue”.

Do not enter a middle name, even if used in the previous Lobbyists Registry.
Enter Email address | If you still have access to it, enter the Email address you used in the
BC Lobbyists Registry prior to May 4, 2020, then click “Submit”. If you
no longer have access to that email address, stop and contact
Registry staff at info@bcorl.ca. Ask them to update your email
address before you proceed.

If a name or email match cannot be found, email Registry staff at info@bcorl.ca describing the
steps you followed and the problem you encountered. Include relevant screen captures to help
us understand your issue. Include a phone number we can call if needed.

Re-activation email | You MUST re-activate your account before you can submit
Registration Returns, updates or Lobbying Activity Reports.

You will be sent an email to re-activate your account. Click the link in
the email to re-activate your account.

Username/Password

After account re-activation, you will be prompted to create a Username and Password for the
account you are re-activating.

Username and Enter a Username and Password.

Password
Usernames and passwords are case sensitive and must be at least 6

characters long.

Once your account is re-activated, you can sign in to the Lobbyists Registry to create or update
a Registration Return and Lobbying Activity Reports.
The Dashboard

You will manage your Registration Return and Lobbying Activity Reports from the Designated
Filer Dashboard, as well as your Designated Filer account.


mailto:info@bcorl.ca
mailto:info@bcorl.ca
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The main section of the dashboard allows you to:
e Create a new Registration Return
e View and update current Registration Return
e Create new/view previous Lobbying Activity Reports
e View and Re-activate previous Registration Returns (under Previous Registrations tab)

The “Designated Filer Menu” on the left allows you to:
e Update your account
e Sign out of the Lobbyists Registry

Update your Account

You can update the following information on your account:
e Mailing/business address
e Email address (including adding additional email addresses)
e Password
e Add or remove an Account Representative

Account Profile After signing in, click on “Account Profile” in the left-hand menu of
your Designated Filer Dashboard.

Designated Filer Click on the “Designated Filer Profile” tab, then click “Edit Account”.
Profile
This will allow you to update your:
e Mailing address
e Email address(es)

If you need to update your legal name, contact Registry staff by

emailing info@bcorl.ca.

Password Click on the “Password” tab, then click “Edit Password”.

Your username cannot be changed.

Account An Account Representative may provide administrative services such
Representatives as preparing and updating your Registration Returns and Lobbying
Activity Reports.

Click on the “Account Representative” tab to:

e Add an Account Representative
e Remove an Account Representative



mailto:info@bcorl.ca
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The Representative must create and activate their own
Representative account first, then give you their Representative
Account Number.

See Quick Reference Guide for Representatives for the steps to Add
a Representative or to Remove a Representative.

Forgotten password or username
Forgotten username
If you forget your username, contact Registry staff via email info@bcorl.ca.

Forgotten password

Start Process | Click “Have you forgotten your password?”.

= Lobbyists Registry Sign In

Look under the Help menu item at the top of each page for links to Guidance Documents, FAQs, Using the Registry & User Guides, and the Lobbyists
Transparency Act and Regulation

© Two New Features in the Lobbying Activity Report:
1. Adding MLAs: provides the ability to add one or more MLAs, including an option to add all MLAs
2. Coalition activity Checkbox: provides the ability to declare a coalition activity

Sign In Register

Please read carefully before proceeding

& Usemame

« Consultant Lobbyist: if you receive payment to lobby or arrange meetings on
behalf of a client, you must create your own account to register lobbying
activities with the Lobbyists Registry.

.

Have you forgotten your password?

’

* Organizations: @ If your functions as an employee, officer or director of an

S organization include lobbying of BC public office holders, and you receive
Sign In remuneration of any kind, your organization must create an account to register
lobbying activities within the Lobbyists Registry. For organizations, the most

senior paid officer is required to create an account as the designated filer.

Note: If you had a registration in the BC Lobbyists Registry between 2010
and May 4, 2020 you can activate your account here.

Create an Account

Username Enter your username and click on “Continue”.

An email will be sent to you with a link to the “change password page”. Go
to your email and click this “change password page” link.

Enter and Enter your Username and then enter and confirm your new password. Click
Confirm New | “Save”.
Password If you have signed up for 2-Factor Authentication (using SMS) to reset

password, you will be sent an SMS message with a one-time code. Enter this
one-time code, then click “Save”.

10
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Links beside Pending Registration Return/Active Registration Return

Under the “Current Registrations” tab on the Designated Filer’s Dashboard, you will see one or
more of the following links beside Pending Registration Return/Active Registration Return.
You may update a current Registration Return by clicking the appropriate link beside ‘Pending
Registration Return’ or ‘Active Registration Return’.

View ©

Click to see the active Registration Return

Update registration if required ©

Click to update the active Registration Return. This
creates a pending Registration Return which you can
edit and submit for activation.

Incomplete ©

You started a new Registration Return or an update to
an existing Registration Return or started to reactivate
an inactive Registration Return. Information is still
required.

Click to review/edit & submit the Registration Return
to the Registry for activation.

Requires certification ©

You started a new Registration Return or an update to
a Registration Return or started to reactivate an
inactive Registration Return.

Click to review/edit & submit the Registration Return
to the Registry for activation.

Delete pending @

Click to delete a pending new, update or reactivation
of a Registration Return that has not been activated by
Registry staff.

Note: If there is an existing active registration, it will
not be affected.

Correction required 2]

You submitted a new Registration Return or an update
to a Registration Return or a reactivated Registration
Return. Registry staff sent it back to you for
correction. You may receive an email with details.

Click to see notes from staff & to enter corrections.

Submitted ©

You submitted a new Registration Return or an update
to an existing Registration Return or a reactivated
Registration Return to the Registry.

Click to view the submitted Registration Return.

End registration 2]

Click to deactivate an active registration if lobbying
activity has stopped. Note: you must reactivate a
Registration Return within 10 days of resuming
lobbying activity.

11
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REGISTRATION RETURNS

Create a New Registration Return

1. Go to the Lobbyists Registry sign-in page
https://www.lobbyistsregistrar.bc.ca/app/secure/orl/Irs/do/Ign and Sign in to your account.

2. On the Designated Filer Dashboard, click the tab for “New Registrations”.

3. To create a new Registration Return on behalf of your organization, select “Organization”.

Registration types

Consultant Lobbyist
Use this registration type if you are an individual who, for payment, will lobby on behalf of a client.

Create a new registration from an existing_consultant lobbyist registration
Use this registration type if you would like to copy an existing consultant lobbyist Registration Return. For the
next step, you must know the registration number of the existing Registration Return.

ﬁ Organization
S gistra e if you are the most senior officer for an organization which has lobbied or will be
lobbying BC public offf ders. The registration must include the names of all employees, officers or directors

of the organization who perform lobbying activities.

4. On the New Registration - Start Date screen, enter the date of the first lobbying activity
(since May 4, 2020). The end date is an optional field. Click “Continue”.

Step 1 of 7: Designated Filer and Organization Information

Designated Filer Enter the Position title of Designated Filer.

The Designated Filer’s email address is auto-populated from
information in the account profile. To update the email address,
return to the Designated Filer Dashboard and update your Account
Profile.

The Designated Filer’s name cannot be updated by filers. If you need
to update your name, contact Registry staff at info@bcorl.ca.

12
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Organization Name
and Contact
Information

Enter the exact legal name of the organization and the
organization’s email address.

Enter the Organization’s mailing address and telephone number.

If the Organization is located outside of Canada and the United
States, fill out the “Other Country” section.

Description of
Organization

Enter a brief description of the organization’s business activities.

Do not use acronyms or abbreviations unless the meaning will be
clear to all readers.

Gifts or Benefits
Provided to Public
Office Holders

For more information, see our guidance on LOBBYIST GIFTS.

If an in-house lobbyist for your organization has given any gifts or
provided any benefits within the last 12 months to public office
holders your organization is lobbying, you must declare the gifts or
benefits in the organization’s Registration Return.

If you have gifts or benefits to declare, click “Add Gifts or Benefits”.
Record the details of the gift or benefit as required.

Step 2 of 7: Coalition Information

For more information, see our guidance on Coalitions

Coalition Members

Declare whether your organization is a member of a coalition by
selecting Yes or No from the drop-down menu.

If Yes, click “Add/Edit Coalition Members” then add the name &
business address of the other organizations that are members of the
coalition.

Step 3 of 7: Affiliates and Contributors with a Direct Interest

For more information, see Business Relationships: Affiliates and Others with an Interest in the

Lobbying Activities

13
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Affiliates with a Declare whether your organization has affiliates that could have a
Direct Interest in the | direct interest in the outcome of the lobbying activities by selecting
Outcome Yes or No from the drop-down menu.

The term “affiliates” is a defined term. For more information, click
the @ button in the form.

If Yes, click “Add/Edit Affiliates” and enter information.

Others with a Direct | Declare whether your organization’s activities are controlled or
Interest in the directed by another person or organization with a direct interest in
Outcome the outcome of the lobbying activities by selecting Yes or No from
the drop-down menu.

If Yes, click “Add/Edit Other Direct Interests” and enter information.

Contributors with a Declare whether any person or organization with a direct interest in
Direct Interest in the | the outcome of the lobbying activities has contributed over $1,000
Outcome CDN in the past 12 months selecting Yes or No from the drop-down
menu.

If Yes, click “Add/Edit Contributors” and enter information.

Step 4 of 7: In-House Lobbyists

You must provide the following information for each in-house lobbyist:
e Any former public office holder positions held by the lobbyist
e Whether the lobbyist made any political, sponsorship or recall contributions since the
date the writ was issued for the last provincial election.

If you do not have this information ready, click “Cancel” at the bottom of the screen. All details
already entered in your Registration Return will be saved for you and you can return and finish
at a later time.

Note: If your organization has many in-house lobbyists, you may wish to save your work
periodically. Click “Save” at the bottom of the screen to ensure the information you have

entered is saved. This will take you to the Organization Summary screen.

To resume entering information about in-house lobbyists, click “Edit” in the heading of the In-
house Lobbyists section and add lobbyists.

14
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Add the Designated
Filer as a Lobbyist

If the Designated Filer is also an in-house lobbyist, click “Add the
Designated Filer as a Lobbyist” button.

Add/Edit In-House
Lobbyist Information

Click “Add Lobbyist” button.

Enter the First name and Last name of one lobbyist.

Former Public Office
Holders

Declare whether the lobbyist is a former public office holder by
selecting Yes or No from the drop-down menu.

Click the @ button in the form for an explanation of the term “former
public office holder”.

If Yes, record the former public office holder position(s).

If the lobbyist held a former public office holder position within the
past two years, they are not permitted to lobby unless an exemption
has been granted by the Registrar. Enter the exemption number in
the field given.

Contributions

Declare whether the lobbyist plans to lobby an MLA or has lobbied an
MLA since the date of the writ for the last provincial election.

If Yes, declare whether the lobbyist has made a political, sponsorship
or recall contribution since the date of the writ for the last provincial
election.

For more information, see
e POLITICAL, SPONSORSHIP, AND RECALL CONTRIBUTIONS; and
e HOW TO REPORT POLITICAL, SPONSORSHIP AND RECALL
CONTRIBUTIONS IN THE LOBBYISTS REGISTRY

Relevant Codes of
Conduct

Declare whether the lobbyist has an undertaking to comply with a
relevant code of conduct by selecting Yes or No from the drop-down
menu.

If Yes, click “Add/Edit Codes of Conduct Details” and enter the
required information about the relevant code of conduct.

For more information, see Codes of Conduct.

Save your entries

When you finish entering the required information for an in-house
lobbyist, click “Save”.

15
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Repeat the steps until information about all in-house lobbyists has
been entered.

Click “Continue” or “Return to Registration Summary”

Step 5 of 7: Government Funding

Government
Funding

For more information see Government Funding and How to Report
Government Funding in the Lobbyists Registry.

Declare whether your organization requested and/or received funding
from any government, government agency or Provincial entity in the 12
months preceding the effective date of the registration or update,

by selecting Yes or No from the drop-down menu.

If Yes, click “Add New”. Enter dates and amounts of government funding
received AND government funding requested, in the 12 months
preceding the effective date of the registration or update.

Click “Save and Create New” to add another government funding entry.

Click “Save” to review the List of Government Funding you have entered.
Edit by clicking the pencil icon, if necessary.

Click “Save” to return to the Organization Summary screen or “Save and
Continue” to move on to the next section.

Step 6 of 7: Subject Matter of the Lobbying Activities

Arranging Meetings
for Others

Declare whether any of the lobbyists in your organization will arrange
meetings between another person and a public office holder for the
purpose of lobbying by selecting Yes or No from the drop-down
menu.

Details of Lobbying
Activities

Describe a specific topic about which you are lobbying in concise
language. Provide enough detail for the general reader to understand
the legislation, government policies or decisions you are seeking to
influence.
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n u

Do not use wording such as “providing information”, “educating” or
“making the government aware”. These do not meet the definition of
“lobby” and will not be accepted.

Do not use acronyms or abbreviations unless the meaning will be
clear to all readers.

Intended Outcomes

Choose the intended outcomes related to that specific lobbying topic
by selecting the appropriate checkboxes.

Associated Subject
Matters

Choose the associated subject matters for that specific lobbying topic
in the box provided.

Click on the text box; select subject matters related to the topic.
Select one or more subject matters for each specific lobbying topic.

Add to List

After one specific topic together with the intended outcomes and
subject matters related to that specific topic have been entered, click
“Add to List”. This will create a separate row for that specific topic.

If the organization is lobbying about more than one topic, create
separate rows: enter another specific topic description, intended
outcomes and associated subject matters for another specific topic,
then click “Add to List”. Repeat as needed.

Review your entries in the “List of Details” near bottom of the screen.

Step 7 of 7: Public Agencies and Members of the BC Legislative Assembly Information

Ministries and
Provincial Entities

Select all Ministries and Provincial entities the organization is lobbying
or intends to lobby.

If you have lobbied or intend to lobby an MLA, select “Member(s) of
the Legislative Assembly”. You will identify specific MLAs lobbied in
your Lobbying Activity Reports, but not in the Registration Return.

For more information on Provincial entities, see our guidance.

If you do not see an agency on the list that you believe should be
there, please contact Registry staff at info@bcorl.ca.
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Save and Finish Later

1. Atthe bottom of each registration screen you can click on the “Save” button. If all required
information has been completed for that screen, your information will be saved and you’ll
be taken to the Organization Summary screen.

2. If you do not have the information required to complete a step in your Registration Return,
click “Cancel”. Completed information from previous screens will not be lost! You will return
to the Organization Summary screen and that information will be saved.

—— J

Click the Save button to view the Registration SummBiry
Click the Save and Conti button to view the next page of the registration frm
Click the Cancel button to return to the Registratio mary without saving any changes to thi ge

Save and Continue

Submit your Registration Return

Review Your Return

Review Organization | Review your Organization Summary for completeness and accuracy.
Summary If any sections are incomplete or inaccurate, click the “Edit” button in
the heading for that section.

Lobbying Activity In the box at the top of the Organization Summary screen, double-
Dates check the Date when lobbying activities first began. On a new
registration, this should be the date of the organization’s first
lobbying activity. Click “Edit” to correct the date, if needed.

Entering the Date when the lobbying for this organization will end is
OPTIONAL.

Certify and Submit your Registration Return

Note: You will only be able to submit your registration once all sections are complete.

A completed section is indicated by a green heading with a check mark. ©

18



BC Lobbyists Registry: Quick Reference Guide for Organizations, October 2021

If you have an incomplete section (yellow/brown heading with this icon o ), click the “Edit”
button in the heading to complete the information, then Save.

Proceed to
Certification

If all information in your Registration Return is complete and
accurate, click the “Proceed to Certification” button at the bottom of
the Organization Summary screen.

Compliance
Statements

Make sure the “Date when lobbying activities first began” is accurate.
Read the three statements and confirm your compliance by ticking
the check boxes.

Enter Username and
Password, then
Submit

Enter the Designated Filer’s username and password.
Click “Submit”.

If you are a Representative preparing this registration on behalf of the
Designated Filer, you will not be able to submit the registration with
your own user name and password. The Registration Return can only
be submitted after entering Designated Filer’s username and
password.

The Registration Return is now locked and cannot be updated until
Registry staff activate or send it back for correction.

Update a Registration Return

Locate the
Registration Return

On the Designated Filer Dashboard select the tab “Current
Registrations”.

Locate the Registration Return to be updated and click the
appropriate link. See explanation of links here: Links beside Pending
Registration Return/Active Registration Return

Date when the
updates took effect

Are you reporting changes? If so, enter the date the change occurred.

If this is a 6-month return and/or you have no changes to report, you
may enter today’s date as the effective date of the update.

OPTIONAL: date when the lobbying activity will end
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Update the
Information

On the Organization Summary screen, scroll down to find the
sections that need updating. Click “Edit” in section headings to revise
information.

Make the required changes and click “Save” to return to the
Organization Summary screen or “Save and Continue” to move to the
next step of the Registration Return.

Change an Answer
in your Registration
Return from Yes to
No

In some sections, if you previously selected “yes” and entered
supporting details/information, you will not be able to change “yes”
to “no” until you delete the details/information related to the ‘yes’
answer.

Locate the details/information you previously entered and click the
“Add/Edit” button.

Select the radio button beside a row of details/information, then click
"Remove Selected".

Repeat for each piece of information that needs to be removed.
When the table is empty, click “Continue”.
You can now change the drop-down menu from “Yes” to “No”.

Proceed to
Certification

Once all updates are complete, scroll to the bottom and click
“Proceed to Certification”.

Certify and Submit
Updates

Confirm compliance by ticking the check boxes.

Enter the Designated Filer’s Account username and Account
password and click “Submit”.

If you are a Representative preparing this update on behalf of the
Designated Filer, you will not be able to submit it with your own user
name and password. The updated Registration Return can only be
submitted after entering the Designated Filer’s username and
password.
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End, Re-activate or Delete a Registration Return

End a Registration Return

If the organization is no longer lobbying, you can deactivate the Registration Return. There are

two ways to do this.

Deactivate
Registration Return
by clicking “End
registration”

On the Designated Filer Dashboard, select the “Current
Registrations” tab. Click “End registration” beside Active
Registration Return.

Using this method, you can deactivate the Registration Return for
today or previous dates.

If you have not yet ceased lobbying, wait until your lobbying is
complete before deactivating the Registration Return using this
method. See next text box to deactivate as of a future date.

Deactivate
Registration Return
by entering future
“Date when the
lobbying for this
organization will
end”

On Designated Filer Dashboard, select the “Current Registrations”
tab. Locate the Registration Return and click the link beside Pending
Registration Return or Active Registration Return to access the
Organization Summary screen. (For explanation of links, see Links
beside Pending Registration Return/Active Registration Return)

Enter the Date when the update took effect - this is the date you
knew your lobbying activity is coming to an end.

Below that, enter the Date when the lobbying for this organization
will end.

Scroll down to the bottom of the Organization Summary screen and
click “Proceed to Certification”.

Submit the changes.

Re-activate a Registration Return

If you resume lobbying activities while the Registration Return is deactivated, you must re-
activate the registration within 10 calendar days of resuming lobbying activities.

Locate the
Registration Return

On the Designated Filer Dashboard, select the tab “Previous
Registrations”.
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Locate the Registration Return and click on the “Reactivate” link.

Enter the date when the lobbying activities resumed for the
organization.

Review and Update
the Information

Review the information on the Organization Summary screen. Click
“Edit” to update any incorrect information.

Make the required changes and click “Save” to return to the
Organization Summary screen or “Save and Continue” to move to the
next step of the Registration Return.

If your Registration Return has been inactive for over 12 months you
will need to re-enter much of your information. Sections where you

need to re-enter the data will be indicated as incomplete Q.

Proceed to
Certification

Once all updates are complete, click “Proceed to Certification” from
the Organization Summary screen.

Certify and Submit
the Registration
Return

Confirm compliance by ticking the check boxes.

Enter the Designated Filer’'s Account username and Account
password and click “Submit”.

If you are a Representative preparing this update/re-activation on
behalf of the Designated Filer, you will not be able to submit it with
your own user name and password. It can only be submitted after
entering the Designated Filer’s username and password.

Delete a New Registration Return or Recent Updates to a Registration Return

You can delete a new, not-yet-activated Registration Return. You can also delete updates made
to an existing Registration Return before the updates have been activated by Registry staff. You
cannot delete a version of your Registration Return that has been activated.

If your Registration Return or updates to your Registration Return were submitted in error and
have already been activated, contact Registry staff at info@bcorl.ca.

Locate the
Registration Return
and Delete

From the Designated Filer Dashboard select the tab “Current
Registrations”.
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Beside Pending Registration Return click “Delete pending”.

If you delete an update to a previously activated Registration Return,
the Designated Filer Dashboard will show the most recent activated
version.

View Previous Versions of your Registration Return

Each time you submit updates to your Registration Return and those updates are activated by
Registry staff, a new version of your registration is created.

The current activated version and all previous activated versions are visible to you and to the
public.

Locate the Locate the Registration Return (from your Designated Filer Dashboard or via
Registration | a public search) and choose to view it.

Return

View Click on the Registration versions drop-down menu to select a previous
Registration | version of the Registration Return.

Version

123 Corp / May Ross, Consultant Lobbyist

Registration Information Associated Lobbying Activity Reports

Client name: 123 Corp Total number of Lobbying Activity Reports: 4
Lobbyist name: May Ross, Consultant Lobbyist
Initial registration start date: 2020-01-14
Registration status: Active

Projected end date: No date provided
Registration number: 5620-2903

Lobbying Activity Reports in the last 6 months:
4

€¢ < Registration versions: |4 of 4 2020-03-17 to present v ‘
Version 4 of 4 (2020-03-17 to present)

MONTHLY RETURNS

Monthly Returns: updates to Registration Returns and Lobbying Activity Reports

If your organization lobbied senior public office holders in a given month, you must file
Lobbying Activity Report(s) by the 15 of the next month.

If your organization did not lobby any senior public office holders in a given month, but
information declared in your Registration Return changed, you must update your Registration
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Return and submit it to the Registry for activation of the updates by the 15th of the next
month.

If you have no lobbying of senior public office holders to report, and all the
information in your Registration Return is accurate and up to date, you are not required to file
anything with the Lobbyists Registry for the preceding month.

If you do not report any lobbying activity and do not update your Registration Return for 5
consecutive months, the Designated Filer, Representative & any other organization contacts
will get an automated email with the steps required to:

1. Keep the Registration Return active; or

2. De-activate the Registration Return (can be re-activated when you are lobbying again).

When to Create a Lobbying Activity Report

You must prepare and submit a Lobbying Activity Report if your organization lobbied one or
more senior public office holders.

Senior public office holders include the following positions:

e Premier and ministers

e Staff of premier/staff of ministers (other than administrative support staff)

e MLAs

e Staff of MLAs (other than administrative support staff)

e Parliamentary secretary

e Deputy minister, chief executive officer or a position of comparable rank in a ministry

e Associate deputy minister, assistant deputy minister or a position of comparable rank in
a ministry

e Senior or next most senior ranking executive position of a Provincial entity

e Chair or vice chair of, or the equivalent position in, the governing body of a Provincial
entity

For more information on the difference between a “public office holder” and a “senior public
office holder”, see the “Public office holders, senior public office holders, former public office
holders” section on the FAQ page.

Review Registration Return Only

If your organization did not lobby any senior public office holders in a given month, the only
requirement is to ensure information in your Registration Return is up to date for the month.
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If your organization lobbied a public office holder who is not a senior public office holder, make
sure your Registration Return declares the subject matter of the lobbying activities and the
public agencies being lobbied, and is otherwise up to date.

Locate Go to the Lobbyists Registry sign-in page
Registration https://www.lobbyistsregistrar.bc.ca/app/secure/orl/Irs/do/Ign and Sign
Return in to your account.
Under the “Current Registrations” tab on the Designated Filer
Dashboard, locate the Registration Return and click “View” beside Active
Registration Return.
Review Review the information in your Registration Return. You must keep it up
Registration to date.
Return
If the information in the Registration Return is complete and accurate,
and your organization did not lobby any senior public office holders in
the preceding month, you have completed your Monthly Return
requirements for this month.
Update If you need to update the information in your Registration Return, go
Registration back to the Designated Filer Dashboard and click the appropriate link.
Return (if See Links beside Pending Registration Return/Active Registration Return
required) for explanation.
Enter the date the change occurred, and click “Continue”.
From the Organization Summary screen click the “Edit” button in the
headings of the sections you need to update.
Enter the required changes and click “Save” to return to the
Organization Summary screen or “Save and Continue” to move to the
next step of the Registration Return.
Certify & Submit | From the bottom right of the Organization Summary screen, click
Updates if “Proceed to Certification” and complete the process to submit the

changes were
made

updates to the Registry for activation.

If you are a Representative preparing this update on behalf of the
Designated Filer, you will not be able to submit the update with your
own user name and password. The updated Registration Return can only
be submitted after entering the Designated Filer’s username and
password.
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Review Registration Return and Create a Lobbying Activity Report

Review and Update Registration Return

Locate Go to the Lobbyists Registry sign-in page
Registration https://www.lobbyistsregistrar.bc.ca/app/secure/orl/Irs/do/Ign and Sign
Return in to your account.
Under the “Current Registrations” tab on the Designated Filer
Dashboard, locate the Registration Return. On the right-hand side, in the
Lobbying Activity Reports section, click “Add New”.
Review The system requires you to review & confirm the information in your
Registration Registration Return as the first step.
Return
If the information in your Registration Return is complete and up to date,
tick the check box at bottom of screen to confirm, then click “Continue”.
Proceed to Step 1 of 3: Lobbying Activity Date (next page in this guide).
Update If you need to make updates to your Registration Return, click the
Registration “Return to Designated Filer Dashboard” link on bottom left of the
Return (if screen.
required)
On the Designated Filer Dashboard, click the appropriate link. See Links
beside Pending Registration Return/Active Registration Return for
explanation.
Enter the date the change occurred, and click “Continue”.
From the Organization Summary screen click the “Edit” button in the
headings of the sections you need to update.
Enter the required changes and click “Save” to return to the
Organization Summary screen or “Save and Continue” to move to the
next step of the Registration Return.
Certify and Back on the Organization Summary screen, click “Proceed to
Submit Updates | Certification” and complete the process to submit the updates to the

(if changes were
made)

Registry for activation.
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If you are a Representative preparing this on behalf of the Designated
Filer, you will not be able to submit it to the Registry with your own user
name and password. The updated Registration Return can only be
submitted after entering the Designated Filer’s username and password.

Once the changes have been submitted to the Registry, return to the
Designated Filer Dashboard and locate your Registration Return again.

The latest updates to your Registration Return show as “Pending” and
will be reviewed by Registry staff. You can proceed with your Lobbying
Activity Report(s) by clicking again on the “Add new” link in the Lobbying
Activity Reports section.

Create a Lobbying Activity Report

Lobbying Activity Date and Senior Public Officer Holders.

Lobbying Activity
Date

Enter the date on which the lobbying activity took place.

Arranging a Meeting | If the lobbying activity was to arrange a meeting between a senior

public office holder and another individual for the purpose of
lobbying, tick the checkbox.

Senior Public Office
Holders Present

Add the required information for each Senior Public Office Holder
who participated in this lobbying activity.

If you lobbied one or more MLAs, click the “Select MLAs” button. On
the new screen, you have an option to select MLAs individually or to
select all. Then click “Add MLAs” at bottom of screen.

When you have entered information about all senior public office
holders who participated in this lobbying activity, click “Next”.

Subject Matter of the Lobbying Activity

List of Details

Identify one or more lobbying activities from the list by selecting the
checkbox(es).

Add new Topics

If you need to add new Topics of Lobbying Communications, click the
“Add a New Detail” button.
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of Lobbying
Communications

The new Topics of Lobbying Communications will automatically be
added to your Registration Return as updates.

If you add new Topics of Lobbying Communications through this
Lobbying Activity Report, you must certify & re-submit your
updated Registration Return by the 15t of the next month.

Lobbyists Who Performed the Lobbying Activity

Select Lobbyists

Select in-house lobbyists who performed the lobbying activity by
using the checkboxes.

Add Lobbyists if
required

If you need to add lobbyists, click the “Add a New Lobbyist” button.

Newly added in-house lobbyists will appear in a box with the heading
New Lobbyists Added, and will automatically be added to this
Lobbying Activity Report.

If you add new lobbyists through this Lobbying Activity Report, they
will automatically be added to your Registration Return in a pending
update. You must certify & re-submit your updated Registration
Return by the 15th of the next month.

Letter Sent on Behalf of Coalition Members

If your Organization
is a Member of a
Coalition

If the lobbying activity you are declaring in this report is not a letter
sent on behalf of one or more of the organizations listed as members
of a coalition in your Registration Return, select ‘No’.

If the lobbying activity you are declaring in this report is a letter sent
on behalf of one or more of the organizations listed as members of a
coalition in your Registration Return, select ‘Yes’.

Select the organizations that are coalition members and signed or
endorsed the letter that you communicated to a senior public office
holder, then click ‘Next’.

Certify Lobbying Activity Report
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Certify Information

Review the information in your report. If it is complete and accurate,
tick the “I certify...” checkbox near the bottom of the screen.

Publishing Options

You have the option of publishing the Lobbying Activity Report now,
or having it published on the next reporting deadline.

To publish the Lobbying Activity Report now, select “Publish Now”
from the drop-down menu.

To publish the Lobbying Activity Report on the next reporting
deadline, select “Publish [date]” from the drop-down menu.

Certify & Submit

Enter the Designated Filer’s username and password and click
“Certify”.

If you are a Representative preparing this on behalf of the Designated
Filer, you will not be able to submit it to the Registry with your own
user name and password. The Lobbying Activity Report can only be
submitted after entering the Designated Filer’s username and
password.

More Lobbying Activity Reports to submit? Click “Return to
Designated Filer Dashboard” and repeat the process.

View a Lobbying Activity Report

Active Registration Return

Locate the Go to the Lobbyists Registry sign-in page
Registration https://www.lobbyistsregistrar.bc.ca/app/secure/orl/Irs/do/Ign and Sign
Return in to your account.
On the Designated Filer Dashboard, under the “Current Registrations”
tab, locate the Registration Return. In the Lobbying Activity Reports
section to the right, click “View”.
View Lobbying Then, select the specific Lobbying Activity Report you wish to see and
Activity Report click “View”.
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Inactive Registration Return

Locate Go to the Lobbyists Registry sign-in page
Registration | https://www.lobbyistsregistrar.bc.ca/app/secure/orl/Irs/do/lgn and Sign in to your
Return account.
On the Designated Filer Dashboard, click the “Previous Registrations” tab.

Open Click on the last inactive version of the Registration Return to load it.
Registration
Return

Previous Activities

Client or Organization Name Last Inactive Version

A Big Organization acﬂve on 2020-04-11 | Reactivate
View In the Registration Return, look for the section near top right of screen with the heading
Lobbying Associated Lobbying Activity Reports. Click on the hyperlinked number of Lobbying
Activity Activity Reports.
Report

A Big Organization / John Davis, CEO
Registration Information Associated Lobbying Activity Reports

Organization name: A Big Organization Total number of Lobbying Activity Repon@

Senior Officer Name: John Davis, CEO @ _
Initial registration start date: 2020-03-17 ;obbylng (Y RENEE D) TS
Registration status: Inactive -

Reqgistration number: 5660-2947

From the list provided, select the Lobbying Activity Report you wish to view and click
“View Lobbying Activity Report”.

Amend or Cancel a Lobbying Activity Report

Locate
Registration
Return

Go to the Lobbyists Registry sign-in page
https://www.lobbyistsregistrar.bc.ca/app/secure/orl/Irs/do/lgn and Sign
in to your account.
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On the Designated Filer Dashboard, under the “Current Registrations”
tab, locate the Registration Return. In the Lobbying Activity Reports
section to the right, click “View”.

Amend Report

From the list of Lobbying Activity Reports, locate the specific Lobbying
Activity Report you need to revise and click “Amend”.

Scroll through the Registration Return and confirm it is up to date, then
proceed through the steps of the Lobbying Activity Report, updating the
information as required.

Once the updates are complete, tick the “I certify...” checkbox and
explain the reason for the amendment.

Cancel Report

On the Designated Filer Dashboard, under the “Current Registrations”
tab, locate the Registration Return. In the Lobbying Activity Reports
section click “View”.

From the list of Lobbying Activity Reports, locate the specific Lobbying
Activity Report you need to cancel and click “Cancel”.

Tick the checkbox to confirm that the lobbying activities did not take
place and/or the Lobbying Activity Report did not need to be submitted.
Enter a Reason for cancellation in the space provided.

The Lobbying Activity Report will remain in your list but will be marked
as “Cancelled” and will not be visible to the public.

CHANGE SENIOR OFFICER/DESIGNATED FILER

If the most senior officer of your organization has changed, the Registration Returns and
Lobbying Activity Reports must be transferred to the new senior officer by the 15% of the

following month.

The new senior officer must have their own account.

The new senior officer will be the Designated Filer for the organization during the time they are
the most senior officer of the organization.
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The Registration Returns and Lobbying Activity Reports for the organization (which are
currently attached to the account of the previous senior officer/Designated Filer) must be
transferred from the previous senior officer to the new senior officer/Designated Filer:

1. If the new senior officer has an existing account (as a Designated Filer for another
organization or as a consultant lobbyist or Representative) they must contact Registry staff
at info@bcorl.ca to have the Registration Returns and Lobbying Activity Reports transferred
to the existing account.

2. If the new senior officer has no existing account they must create a new account. In the
process of creating the new account, the system will transfer the Registration Returns and
Lobbying Activity Reports for the organization and attach them to the new account.

Transfer Registration Return and Lobbying Activity Reports via a NEW senior officer
account/Designated Filer’s account

1. Begin the new account creation process as described above in the section Create a new
Designated Filer account.

2. Enter the exact name of the organization, as currently shown in the Registration Return.

2 Account Creation - Senior Paid Officer Information

Mandatory fields are indicated by an asterisk ( * )

* First name:

* Last name:

* Position title:

* Provide the exact name of the organization.

Organization name: h

3. Fill out the rest of the information on the Senior Paid Officer Information screen and click
“Continue”. If you have entered the exact name of the organization as currently shown in
the Registration Return, the Registry will suggest a Senior Officer Change.

4. Click on the registration number to review the Registration Return to confirm that the
transfer you are requesting is correct.

If this is the correct organization, select “Yes” in the “I confirm...” box.

5. Enter the start date when you began duties as the most senior officer of the organization.
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If the previous Designated Filer was also a lobbyist, indicate whether this individual will
continue to lobby on behalf of your organization.

Indicate whether you will be a lobbyist in addition to being the Designated Filer.

Transfer Registration Return and Lobbying Activity Reports to an existing account with
assistance from Registry staff

If the new senior officer has an existing account with the Registry, they must contact Registry
staff at info@bcorl.ca to have organization’s Registration Returns and Lobbying Activity Reports
transferred to the existing account.

PRINTING A REGISTRATION RETURN OR LOBBYING ACTIVITY REPORT

Locate the
Registration Return
or Lobbying Activity
Report

Locate the Registration Return or Lobbying Activity Report (from your
Designated Filer Dashboard or via a public search) and view it.

Print Registration
Return or Lobbying
Activity Report

With the Registration Return or Lobbying Activity Report loaded on
your screen, use your browser’s print functionality. Usually this can
be accessed via File > Print or by CTRL+P.

The Lobbyists Registry will format your Registration Return or
Lobbying Activity Report for printing and the entire return or report
will be printed in a single document.

Share Registration
Return

There is also an option to share a Registration Return. In the upper
right-hand corner of the Registration Return click on “Share this

page”.

GETTING HELP

Lobbyists Transparency Act and Frequently Asked Questions

Getting Started — Reference Guide (very helpful overview)

The Lobbyists Transparency Act (LTA):
https://www.lobbyistsregistrar.bc.ca/about/legislation/
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LTA Guidance Documents:
https://www.lobbyistsregistrar.bc.ca/lobbyists-transparency-act/Ita-guidance-documents/

Frequently Asked Questions:
https://www.lobbvistsregistrar.bc.ca/lobbyists-transparency-act/Ita-frequently-asked-

questions/

Full Length User Guides

The following user guides provide in-depth support for Organizations:
e User Guide — Account Management
e User Guide — Accounts and Registrations from the Previous Lobbyists Registry
e User Guide — Consultant Lobbyist Registration Returns
e User Guide — Monthly Returns and Lobbying Activity Reports
Contacting Registry Staff

If you are having technical issues with your Account, Registration Return or Lobbying Activity
Report, send us an email at info@bcorl.ca describing the steps you have followed and the
problem you have encountered. Please include any relevant screen captures to help us
understand your issue. Also include a phone number we can call if needed.
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